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Preface
PREFACE Welcome

Purpose of This Manual

This manual contains detailed information about how to configure and 
deploy EtherNet/IP and PROFINET I/O-based applications using 
AutoVISION, Visionscape, and the Vision HAWK Smart Camera.

Manual Conventions
The following typographical conventions are used throughout this manual.

• Items emphasizing important information are bolded.

• Menu selections, menu items and entries in screen images are 
indicated as: Run (triggered), Modify..., etc.
AutoVISION and Visionscape Industrial Protocol User Manual v
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CHAPTER 1 Protocol Switching in 
AutoVISION and Visionscape 
FrontRunner

This section describes how to switch the Vision HAWK between EtherNet/IP 
and PROFINET I/O operation using AutoVISION or Visionscape FrontRunner.
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Chapter 1 Protocol Switching in AutoVISION and Visionscape FrontRunner
Switching between PROFINET I/O and EtherNet/IP

FrontRunner

Go to the File menu and select Configure Device. Go to the Industrial 
Protocols tab.
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Note: When changing protocols, the camera must be rebooted before the 
change will take effect. After clicking OK, you will be given the option to 
reboot the camera now or at a later time.

If you choose No, your newly selected protocol will not be active.
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Chapter 1 Protocol Switching in AutoVISION and Visionscape FrontRunner
1-4 AutoVISION and Visionscape Industrial Protocol User Manual

AutoVISION

In the Connect view, and with a Vision HAWK selected, open Details and 
select the desired protocol from the Industrial Protocol dropdown menu.
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Note: A change to Industrial Protocol requires a reboot of the camera 
before the new setting can take effect.

Choose Yes and the camera will be rebooted for you. AutoVISION will be 
disabled while the reboot is in process. If you choose No, your newly 
selected protocol will not be active until you manually reboot the camera.
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CHAPTER 2 Using EtherNet/IP

This section provides information necessary for using the Vision HAWK in 
an EtherNet/IP environment.

Notes: 

• The camera communications protocol must be enabled for 
EtherNet/IP before it can be used in this environment. Refer to 
Chapter 1, Protocol Switching in AutoVISION and Visionscape 
FrontRunner, for information about enabling and switching 
communications protocols.

• AutoVISION and FrontRunner jobs use Microscan Link functionality 
to accommodate EtherNet/IP communications between the camera 
and the PLC. For information about how to connect job parameters 
and outputs to Microscan Link tags, refer to the Microscan Link > 
Link Menus section of Chapter 4 in the AutoVISION Software User 
Manual, and to the Linking Datums to Microscan Link Tags section 
of Chapter 2 in the Visionscape FrontRunner User Manual.
AutoVISION and Visionscape Industrial Protocol User Manual 2-1



Chapter 2 Using EtherNet/IP
Vision HAWK EtherNet/IP

The EtherNet/IP interface version described here is 1.1. This version 
number is associated with the EtherNet/IP interface for Microscan’s 
Device Type of 100, Machine Vision Smart Cameras. It is not the software 
version number of AutoVISION and Visionscape software, or Vision 
HAWK firmware.

Overview

The EtherNet/IP interface will be identified as Vendor Specific (100). The 
interface is designed to support Class 1 Implicit I/O data exchange, and 
Class 3 Explicit messages for serial commands not accessible with 
Implicit messaging.

Necessary Tools

The following tools are helpful for configuring EtherNet/IP:

• AutoVISION and FrontRunner

• EtherNet/IP Messaging Tool – can be a PLC or Software Tool, must 
be capable ofsending explicit messages and establishing Class 1 
connections. EIPScan from Pyramid Solutions is an example of such 
a tool.

• Terminal emulation or serial communication tool that can connect to 
serial uart and TCP socket, such as HyperTerminal or Putty.

EtherNet/IP Terms of Use

EtherNet/IP Technology is governed by the Open DeviceNet Vendor 
Association, Inc (ODVA). Any person or entity that makes and sells 
products that implement EtherNet/IP Technology must agree to the Terms 
of Usage Agreement issued by ODVA. See www.odva.org for details.
2-2 AutoVISION and Visionscape Industrial Protocol User Manual
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EtherNet/IP Object Model

Vision HAWK uses Class 1 connected messaging to communicate most 
of its data and services in a single connection.

EtherNet/IP Identity

Device Type

Device type is 100, Vendor Specific, Machine Vision Smart Camera.

Vendor ID

Microscan’s ODVA Vendor ID is 1095.

Product Code

The Product Code is 6899.

Interface Revision

Major.Minor  = 1.1

Connection Properties: Class 1 Implicit Messaging

Input Assembly Instance (to PLC/client): 102

Output Assembly Instance (to Vision HAWK): 114 

Size: Fixed, 320 bytes in both directions

Input Trigger/Trigger Mode: Cyclic

RPI (Requested Packet Interval): Greater than 20 ms recommended. 10 
ms to 3.2 s allowed.

Input Type/Connection Type: 

• Point-to-Point (PLC OUT, O > T)

• Point-to-Point (PLC IN, T > O)

Connection Priority: Scheduled



Chapter 2 Using EtherNet/IP
Assembly Layout

Input Assembly

The input assembly layout is described below.
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The input assembly layout is shown here:
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Status: Camera Status Register (16-bit)

Each bit of this register represents a different state of the camera’s operation. A high value 
of 1 indicates that state is active (true).
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CmdCodeRslt (32-bit)

The value of CmdCodeRslt is only valid when ExeCmdAck is active (1), in response to 
ExeCmd being active. 

CmdRet (32-bit)

The value of CmdRet is only valid when ExeCmdAck is active (1), in response to 
ExeCmd being active, and CmdCodeRslt is 0 (Success). The following table shows 
which CmdCodes return data in the CmdRet register.
AutoVISION and Visionscape Industrial Protocol User Manual 2-7
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State (16-bit)

State reflects the following operational condition of the camera:

*Booting (3) State: This will rarely be seen by the PLC.
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The value of State determines which Control and Status signals are available:

Where:

Y = Signal is valid for this State 

Empty table cell = Signal is not valid for this State
AutoVISION and Visionscape Industrial Protocol User Manual 2-9



Chapter 2 Using EtherNet/IP
VIO Register Bits

Output Assembly

The output assembly layout is described below and shown in the following diagram.
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The output assembly layout is shown here:
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Chapter 2 Using EtherNet/IP
Control: Camera Control Register (16-bit)

Each bit of this register controls a function on the camera. Transitions from a low state of 0 to a 
high state of 1, initiates the associate operation. The PLC should return the state of the control 
bit back to 0 after it has acknowledged the camera has processed the control. Unused bits 
should remain 0.

CmdCode and CmdArg (32-bit)

Specifies the process invoked in the camera when Control.ExeCmd goes active.

List of available CmdCodes, and associated CmdArg:
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CmdCode and ExeCmd Operation

VIO Register Bits
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Chapter 2 Using EtherNet/IP
Connection Properties: Class 3 Explicit Messaging

All Class 1 I/O assembly data and additional data are accessible via Explicit message. 
Input data (Vision HAWK to PLC/Client) occupies attributes 1 to 100 of the classes. Output 
data (PLC/Client to Vision HAWK) occupies attributes 101 to 200.

Service: 

• Get Attribute Single (0xE) 

• Set Attribute Single (0x10)

Classes:

• bool =  104 (0x68)

• int = 105 (0x69)

• long = 106 (0x6A)

• float = 107 (0x6B)

• string = 108 (0x6C)

• control/status (mixed data types) = 109 (0x6D)

Instance: 1

Attribute: 

• 1 to 100  = In to PLC/Client

• 101 to 200 = Out to Vision HAWK
2-14 AutoVISION and Visionscape Industrial Protocol User Manual
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Attribute Layout

When using explicit EtherNet/IP messaging, all global data objects can be read or written. 
Each data type is stored in its own class object and an instance of 1 to read the global 
data. For example, to read float2, the EtherNet/IP request would be for Service Code 14 
(0xE), Class 107 (0x6B), Instance 1, Attribute 2. 

The value received in response to Get Attribute Single depends on the type:

• Bool will return a 16-bit word with 0 for false or 1 for true

• Ints will return a 16-bit signed integer

• Longs will return a 32-bit signed integer

• Floats will return a 32-bit floating point number

• Strings will return a counted string. Total size of a string data item is 2048 bytes. This 
includes a 4 byte “length” field followed by 2044 eight bit characters. When accessing 
strings explicitly, they are not limited to the size in the I/O assemblies. For example, 
string3 is limited to 28 bytes in the input assembly. If the actual string is longer than 
28 bytes, it will be truncated when reading via the assembly, but not truncated when 
reading the same string via an attribute explicitly.
AutoVISION and Visionscape Industrial Protocol User Manual 2-15



Chapter 2 Using EtherNet/IP
Assembly Class 109 can be used to read and write special EtherNet/IP-specific 
registers.
2-16 AutoVISION and Visionscape Industrial Protocol User Manual
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EtherNet/IP Control/Status Signal Operation
AutoVISION and Visionscape Industrial Protocol User Manual 2-17
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EDS/CIP Environments
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PLC Tags and Serial Command Names 

PLC tags are separated into IN and OUT for data direction. Within the IN and OUT groups, 
the tags are sub-divided into fixed Status and Control fields, plus user-defined linked data 
fields. This table shows how PLC tag names correspond to serial commands.
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CHAPTER 3 Allen-Bradley AOI (Add-On 
Instructions) for EtherNet/IP 
Operation

This section provides additional instructions helpful for using the Vision 
HAWK in an EtherNet/IP environment.

Notes: 

• The camera communications protocol must be enabled for 
EtherNet/IP before it can be used in this environment. Refer to 
Chapter 1, Protocol Switching in AutoVISION and Visionscape 
FrontRunner, for information about enabling and switching 
communications protocols.

• AutoVISION and FrontRunner jobs use Microscan Link functionality 
to accommodate EtherNet/IP communications between the camera 
and the PLC. For information about how to connect job parameters 
and outputs to Microscan Link tags, refer to the Microscan Link > 
Link Menus section of Chapter 4 in the AutoVISION Software User 
Manual, and to the Linking Datums to Microscan Link Tags section 
of Chapter 2 in the Visionscape FrontRunner User Manual.
AutoVISION and Visionscape Industrial Protocol User Manual 3-1



Chapter 3 Allen-Bradley AOI (Add-On Instructions) for EtherNet/IP Operation
Rockwell RSLogix 5000 AOI (Add-On Instructions) for 
Microscan Devices

The AOI file has been created as basic instructions and as a main rung import. The AOI 
instructions read and write data when called. The main rung import has global tags and 
the AOI itself to demonstrate how the AOI is used for beginners with the RSLogix system. 
The AOI can be used with the EDS file.

Note: Examples in this section have been created using RSLogix 5000 version 20.

Steps

• Install EDS File

• Import AOI File

• Test Communications and Review Data

Install EDS File

In RSLogix 5000, select the EDS Hardware Installation Tool under the main menu Tools.

Click the Next button. Make sure the Register an EDS Files(s) radio button is selected.
3-2 AutoVISION and Visionscape Industrial Protocol User Manual
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Click the Browse button to locate the EDS file (C:\Microscan\Vscape\Firmware\eds\). 
Once the EDS file is located and selected, click the Next button.

Click the Next button for the image. Click the Next button for the summary.

Click the Finish button to complete the EDS installation.
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Chapter 3 Allen-Bradley AOI (Add-On Instructions) for EtherNet/IP Operation
Right-click the Ethernet node on the left pane and select New Module. Enter the part 
number in the filter box to list the device. Select the device from the newly added EDS file. 
Double-click the device or select and click the Create button to add to the project.

Enter the name for your device and the IP address, then click OK.

If the reader has multiple assembly sizes, the Change button allows you to select the 
other assembly formats.
3-4 AutoVISION and Visionscape Industrial Protocol User Manual
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Click the Close button on the module selection dialog to continue. Now the device has 
been added to the project and will be visible in the tree view under the Ethernet node.
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Chapter 3 Allen-Bradley AOI (Add-On Instructions) for EtherNet/IP Operation
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Import AOI File

Right-click the Add-On Instructions node in the tree view in the left pane and select 
Import Add-On Instruction. Locate the L5X file (C:\Microscan\Vscape\Firmware\aoi\) 
and click the Import button.

The Import Configuration dialog will prompt you for information regarding the AOI file. Select 
the Data Types to view the new tags and their attributes. Click OK when ready to continue.

New tags and logic will now be added to the project.
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Test Communications and Review Data

After the reader module has been installed, you can start with a basic ladder logic program 
to test the data to and from the device. 

Select the Add-On tab and add the imported Add-On element to rung 0.
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Right-click in the first element and create a New Tag. This tag will contain all the elements 
of the EnableIn and EnableOut of the AOI.
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Right-click the second element and create a new tag for the Assembly_Input. It will 
default to the AOI INPUT320 data type. Right-click the third element and create a new tag 
for the Assembly_Output. It will default to the AOI OUTPUT320 data type.

Double-click the fourth element and click the down arrow in the combo box to link the 
Connection_Input to the reader input data. The link should be the [reader name]:I.Data.

Note: Do not connect to the ConnectionFault item.

Double-click the fifth element and click the down arrow in the combo box to link the 
Connection_Output to the reader output data. The link should be the [reader name]:O.Data.
AutoVISION and Visionscape Industrial Protocol User Manual 3-9



Chapter 3 Allen-Bradley AOI (Add-On Instructions) for EtherNet/IP Operation
Now download the program to the PLC. Once the program has downloaded, set the PLC 
to Run Mode.

Note: Be sure the path to the PLC has been set in the project so that communications to 
the PLC can be established.

Open the Program Tags window and select the Monitor Tags tab at the bottom. Expand 
the input and output data assemblies. Expand the WriteData element and expand 
CONTROL to locate bit 8 which is the trigger bit. Enter a 1 to toggle the bit, which will 
trigger a read.
3-10 AutoVISION and Visionscape Industrial Protocol User Manual



4

A
lle

n
-B

ra
d

le
y 

P
L

C
 

S
et

u
p

 v
ia

 E
D

S

4

CHAPTER 4 Allen-Bradley PLC Setup 
via EDS for EtherNet/IP 
Operation

This section describes how to use an EDS file to set up an Allen-Bradley 
PLC for EtherNet/IP operation.

Notes: 

• The camera communications protocol must be enabled for 
EtherNet/IP before it can be used in this environment. Refer to 
Chapter 1, Protocol Switching in AutoVISION and Visionscape 
FrontRunner, for information about enabling and switching 
communications protocols.

• AutoVISION and FrontRunner jobs use Microscan Link functionality 
to accommodate EtherNet/IP communications between the camera 
and the PLC. For information about how to connect job parameters 
and outputs to Microscan Link tags, refer to the Microscan Link > 
Link Menus section of Chapter 4 in the AutoVISION Software User 
Manual, and to the Linking Datums to Microscan Link Tags section 
of Chapter 2 in the Visionscape FrontRunner User Manual.
AutoVISION and Visionscape Industrial Protocol User Manual 4-1



Chapter 4 Allen-Bradley PLC Setup via EDS
AB Rockwell RSLogix 5000 v20 PLC Integration with EDS

This section was created and run on the following Allen Bradley/Rockwell components:

• RSLogix 5000 Version 20.00.00 (CPR 9 SR 5)

• 756-L61 ControlLogix5561 Controller, firmware rev 20.11

• 1756-ENBT/A EtherNet/IP interface card, firmware rev 4.1

Run the Rockwell EDS Hardware Installation Tool.
4-2 AutoVISION and Visionscape Industrial Protocol User Manual
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Select Add.

Select Browse.
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Chapter 4 Allen-Bradley PLC Setup via EDS
Navigate to the VisionHAWK EDS file, then Open it. The default install location is 
C:\Microscan\Vscape\Firmware\eds\visionhawk.

Keep clicking Next until the Finish button is displayed. 
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Click Finish.

Open RSLogix 5000 v20 and create the I/O Configuration for the base system, including 
the system’s Ethernet interface.
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Chapter 4 Allen-Bradley PLC Setup via EDS
Right-click Ethernet and select New Module.

The Select Module Type dialog will be displayed.
4-6 AutoVISION and Visionscape Industrial Protocol User Manual
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Clear the Module Type Vendor Filters.

Scroll down the Module Type Vendor Filters until Microscan comes into view, then select 
Microscan.
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Chapter 4 Allen-Bradley PLC Setup via EDS
Click the required camera and click Create.

The New Module dialog is displayed. Type a unique name for this camera and its IP address.
4-8 AutoVISION and Visionscape Industrial Protocol User Manual
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Click OK, verify the camera was added to the Ethernet network, then open the controller 
tags to verify that :I and :O tag sets were created.

Open the Main Routine.
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Chapter 4 Allen-Bradley PLC Setup via EDS
Right-click rung 0, and select Import Rungs.

Navigate to the Vision HAWK 32-000003-2.L5X file and select Import. The default install 
directory is C:\Microscan\Vscape\Tutorials and Samples\Vision Hawk\EIP Demo.
4-10 AutoVISION and Visionscape Industrial Protocol User Manual
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The Import Configuration dialog will be displayed.

Select Tags.
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Chapter 4 Allen-Bradley PLC Setup via EDS
In the Final Name column, click Camera:I, then click the down arrow that appears on the right.

Double-click the camera name input tag assigned earlier.
4-12 AutoVISION and Visionscape Industrial Protocol User Manual



AB Rockwell RSLogix 5000 v20 PLC Integration with EDS

A
lle

n
-B

ra
d

le
y 

P
L

C
 

S
et

u
p

 v
ia

 E
D

S
 f

o
r 

4

In the Final Name column, click Camera:O, then click the down arrow that appears on the right.

Double-click the camera name output tag assigned earlier.
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Chapter 4 Allen-Bradley PLC Setup via EDS
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Click the Other Components icon in the tree view to select the Component References. 
Select the camera in the Final Name column. Click OK to complete the import. 

Click OK and the Main Routine and User-Defined tags will be populated.
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Delete any empty rungs (check rung 0).

Download the project to the PLC.

Note: Be sure the path to the PLC has been set in the project so that communications to 
the PLC can be established.

Put the PLC in Run Mode.
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Chapter 4 Allen-Bradley PLC Setup via EDS
Open the Program Tags window and select Monitor Tags.
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Expand Scan_MV_IO_user so that the Echo in the .IN.Status and .OUT.Control 
structures is visible.
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Chapter 4 Allen-Bradley PLC Setup via EDS
Change .OUT.Control.Echo to non-zero.

Verify that Scan_MV_IO_user.IO.IN.Status.Echo is the same value as the 
.OUT.Control.Echo.

This confirms that the PLC and camera have successful two-way communication. 

The demo code expects a demo vision job to be loaded on the camera, which populates 
the following input tags (camera to PLC) with vision tool results:

• .IN.bool.bool1, bool2, and bool3

• .IN.long.long1

• .IN.float.float1

• .IN.string.string1

The demo code will operate the Control and Status signals of the camera regardless of 
the vision job that is loaded. For a more detailed overview of the demo code and vision 
job, see Allen-Bradley PLC Setup via Generic Ethernet Module for EtherNet/IP 
Operation. 

To send a trigger to the camera, scroll to Scan_MV_IO_user.Control.Trigger.
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Set the Trigger to 1. This causes the demo code to trigger the camera, process the new 
inspection data, record the results in the Scan_MV_demo_xxxx tags, and clear the 
DataValid status signal. 

The Trigger control changes to 0 when the camera is triggered. All processing is done 
when the counter Scan_MV_dv_fall_count increments, along with the pass/fail counters 
in the Scan_MV_demo_xxxx tags.
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CHAPTER 5 Allen-Bradley PLC Setup via 
Generic Ethernet Module for 
EtherNet/IP Operation

This section describes how to use the Generic Ethernet Module to set up 
an Allen-Bradley PLC for EtherNet/IP operation.

Notes: 

• The camera communications protocol must be enabled for 
EtherNet/IP before it can be used in this environment. Refer to 
Chapter 1, Protocol Switching in AutoVISION and Visionscape 
FrontRunner, for information about enabling and switching 
communications protocols.

• AutoVISION and FrontRunner jobs use Microscan Link functionality 
to accommodate EtherNet/IP communications between the camera 
and the PLC. For information about how to connect job parameters 
and outputs to Microscan Link tags, refer to the Microscan Link > 
Link Menus section of Chapter 4 in the AutoVISION Software User 
Manual, and to the Linking Datums to Microscan Link Tags section 
of Chapter 2 in the Visionscape FrontRunner User Manual.
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Integrating the Camera into a PLC Environment

This section assumes you are using an Allen Bradley PLC with Rockwell RSLogix 5000 v16 
or newer. RSLogix v19 and v20 may look slightly different than the screen shots shown, but 
the integration process is similar.

Create the I/O Configuration for the base system, including the system’s Ethernet interface. 

Add the camera by right-clicking the Ethernet interface and selecting New Module.
5-2 AutoVISION and Visionscape Industrial Protocol User Manual



Integrating the Camera into a PLC Environment

A
lle

n
-B

ra
d

le
y 

P
L

C
 

S
et

u
p

 v
ia

 G
en

er
ic

 

5

Select ETHERNET-MODULE – Generic Ethernet Module, and click OK.
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Configure the following fields:

Name: A useful name to rememberfor the camera. The example here is Scan_MV.

IP Address: The IP Address of the camera

Comm Format: “Data – DINT”

Input, Assembly Instance: 102 

Input, Size: 80 

Output, Assembly Instance: 114

Output, Size: 80

Configuration, Assembly Instance: 1

Configuration, Size: 0 (none)

Click OK when done.

Example:
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Configure the Required Packet Interval (RPI) and click OK. 

10 ms is the minimum allowed by the camera. 20 ms or higher is recommended.

Open the Main Routine.
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Right-click the top rung and select Import Rung.

Navigate to the 32-000003-2.L5X file and click Import.
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AutoVISION and Visionscape Industrial Protocol User Manual 5-7

At the Import Configuration window, find the Module Name that was assigned to the 
Generic Module. Here the module name is Camera.

Click Camera:I and click the down arrow, then double-click the Scan_MV:I that appears 
below it.



Chapter 5 Allen-Bradley PLC Setup via Generic Ethernet Module
Click Camera:O and click the down-arrow, then double click the Scan_MV:O that appears 
below it.

Click the Other Components icon in the tree view. Click OK.

Delete any empty rungs (rung 0 may be empty).

The tags and main program are now configured sufficiently to test communication with the 
camera.
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Select the control button next to Offline and then select Download.

Note: Be sure the path to the PLC has been set in the project so that communications to 
the PLC can be established.
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Once the program has downloaded, make sure the PLC is in Run Mode.

To open the Program Tags, double-click Program Tags, then select the Monitor Tags tab 
at the bottom of the tag window.
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Expand Scan_MV_IO_user so that the .IN.Status and .OUT.Control structures are 
visible. Then scroll the window so Scan_MV_IO_user.OUT.Control.Echo is visible.
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Change .OUT.Control.Echo to non-zero.
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Scroll the window so Scan_MV_IO_user.IO.IN.Status.Echo is visible, and verify that it is 
the same value as .OUT.Control.Echo.

This confirms that the PLC and camera have successful two-way communication. 
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To send a trigger to the camera, scroll to Scan_MV_IO_user.Control.Trigger.



Integrating the Camera into a PLC Environment

A
lle

n
-B

ra
d

le
y 

P
L

C
 

S
et

u
p

 v
ia

 G
en

er
ic

 

5

Set the Trigger to 1. This causes the demo code to trigger the camera, process the new 
inspection data, record the results in the Scan_MV_demo_xxxx tags, and clear the 
DataValid status signal. The Trigger control changes to 0 when the camera is triggered. 
The Scan_MV_dv_fall_count and pass/fail counters in the Scan_MV_demo_xxxx tags 
increment when all processing is done. For example:
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Parameterize the Camera

Open the Scan_MV_IO_user.OUT.long, float, and string tags and verify that they are 
configured as shown below.

This configures the Measure (float101 and float102), Decode (string101) and Count 
Blob (long101 and long102) tools in the same way they were configured in AutoVISION 
during Try Out.

Note the Description column. It offers a hint for what each linked tag does in the vision job.
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Trigger the Camera

To send a trigger to the camera, scroll to Scan_MV_IO_user.Control.Trigger. 

Set the Trigger to 1. When the Trigger returns to a value of 0, the camera may be re-triggered.

If you connect to the camera with AutoVISION, it will display a new inspection result each 
time the camera is triggered. Recall that the vision job was created with predefined 
images to produce predictable Passed and Failed results. The camera’s illumination 
lights will not flash when triggered.

The inspection results can be seen in the PLCs’s IN tags, as well as in AutoVISION. Open 
the RSLogix tag window so Scan_MV_IO_user.IN.Status and bool are visible. 
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This example shows a Passed inspection, where the following tags are all 1:

• IN.Status.InspStat

• IN.bool.bool1 (Measure status)

• IN.bool.bool2 (decode+matchcode status)

• IN.bool.bool3 (count blob status)
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If you scroll down to the IN.long, float, and string values, you will see the literal results of 
the vision tools.
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This is equivalent to the AutoVISION inspection result.

This example shows a Failed inspection, where every tool reports a fail.
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This is the Failed inspection’s literal data.

This is equivalent to the AutoVISION inspection report.
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Parameterize the Camera Again

The Measure and Count Blob tools can be parameterized by the PLC so they always 
pass. The Decode Tool can be parameterized so it always fails, either due to no decode, 
or a Match Strings mismatch. Scroll the tag window so OUT.long, float, and string are 
visible, then change them as shown below.
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Trigger the Camera Again

Trigger the camera twice and you will see the Status results stay the same for all triggers:

bool2 (decode+matchcode status) = 0

Why: Decode + Matchcode status always fails because the matchcode has been changed 
to wrong code, or there is no decode.

bool1 (Measure status) and bool3 (count blob status) = 1

Why: The inspected values are now within tolerance.

InspStat = 0

Why: The Decode tool fails, so the overall Inspection result is a Fail.

PLC tags:

This concludes the EtherNet/IP demo.
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CHAPTER 6 Demo EtherNet/IP PLC Code

This section describes how to use Microscan demo PLC code with a 
vision job and camera target.

The EtherNet/IP demo files can be found where AutoVISION is installed, 
in the folder C:\Microscan\Vscape\Tutorials and Samples\Vision 
Hawk\EIP demo. Open the EIP_demo.avp with AutoVISION and 
download it to the camera. 

During PLC integration, import the 32-000003-2.L5X file to create the 
camera’s demo tags and ladder logic.

Notes: 

• The camera communications protocol must be enabled for 
EtherNet/IP before it can be used in this environment. Refer to 
Chapter 1, Protocol Switching in AutoVISION and Visionscape 
FrontRunner, for information about enabling and switching 
communications protocols.

• AutoVISION and FrontRunner jobs use Microscan Link functionality 
to accommodate EtherNet/IP communications between the camera 
and the PLC. For information about how to connect job parameters 
and outputs to Microscan Link tags, refer to the Microscan Link > 
Link Menus section of Chapter 4 in the AutoVISION Software User 
Manual, and to the Linking Datums to Microscan Link Tags section 
of Chapter 2 in the Visionscape FrontRunner User Manual.
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Glossary of Terms

The following terms are used in the description of Microscan’s demo PLC 
program.

Camera

The Microscan Smart Camera used in this application, which has an 
EtherNet/IP communication interface.

User App

The PLC logic code written by the end user or system integrator.

Demo Code

The PLC logic code distributed by Microscan that can be imported into the 
PLC’s ladder logic area. It encapsulates most of the device Control and 
Status management.

The demo code expects a demo vision job loaded on the camera. 
However, the demo code will operate whether or not the demo vision job 
is loaded on the camera.

Activate / Set High

Writing a 1 value to a single Control bit, or any other bool bit.

Active 

A Control, Status, bool, or PLC logic “contact” in a 1 state.

Clear 

A Control, Status, bool, or PLC logic “contact” in a 0 state.

One Shot

A PLC tag write operation that is performed once, typically in reaction to 
an event. After a one shot operation, the PLC logic does not write to the 
same tag again unless another event occurs.
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Demo Setup

Vision Job Setup

The EtherNet/IP demo files can be found where AutoVISION is installed, 
where the default folder is C:\Microscan\Vscape\Tutorials and 
Samples\Vision Hawk\EIP demo. 

1. Open EIP_demo.avp with AutoVISION.

2. To use pre-defined images, select the icon shown here.

3. Browse to the EIP demo folder, select it, and click OK.
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Chapter 6 Demo EtherNet/IP PLC Code
After the EIP demo folder has been enabled for image load, the 
camera icon will change to a folder.

4. While in Edit mode, Try Out can be used to get an understanding of 
what to expect after the job is sent to the camera.

Before Try Out can be effective, the Measure, Decode, and Count 
Tool parameters must be specified. After job download, the tool 
parameters will be supplied by the PLC.

Measure Tolerance:

Decode Matchstring:

Count Tolerance:
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With these tool parameter configured as shown, Try Out will show the 
following Pass/Fail results:

Fail:

Pass:

5. Download the job to the camera.

6. Add the camera and demo code to the PLC environment (see the 
next section).

PLC Demo Code Setup

During PLC integration, import the 32-000003-2.L5X file found in the EIP 
demo folder to create the camera’s demo tags and ladder logic (refer to 
the Allen-Bradley PLC Setup chapters).
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Description of PLC Tags

Scan_MV_demo_mode

Purpose

This tag is intended for demonstration purposes only. It modifies the 
operation of the demo code and allows the first-time user to control the 
device directly with no assistance from the demo code. It also allows the 
demo code to manage the Control and Status signals fully.

The demo mode tag takes three different values, putting the demo code 
into one of three modes of operation: 

• Exchange I/O data only

• Actively operate device controls, status, and demo data

• Automatically trigger the device after one second of idle time

User App Method

User app can set the demo mode with one of three values to define the 
demo code’s mode of operation.

0 = Exchange I/O data only

In this mode, the user directly accesses the Scan_MV_IO_internal tag 
set. The demo code only exchanges data with the camera, doing nothing 
to control the device or respond to events from it.

1 = Operate device controls and respond to device events

This is the default mode of the demo code. In this mode, the user app 
accesses the Scan_MV_IO_user tag to control and monitor the camera. 
The user app must not access the Scan_MV_IO_internal tag set. 

In this mode, the user activates the controls in 
Scan_MV_IO_user.OUT.Control (Trigger, ResetCount, GoOnline, 
GoOffline, ResetError, ExeCmd), and the demo code handles the rest.

2 = Auto-trigger
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In this mode, the demo code fully manages the Control and Status 
signals, the same as when the mode is set to 1. It also activates the 
camera’s trigger after one second of idle time. The timer used to drive the 
trigger is Scan_MV_trigger_delay_timer.

Demo Code Usage

Depending on the mode, the demo code will run the appropriate level of code. 

• In mode 0, only the I/O exchange rungs are executed. All others are 
bypassed. 

• In mode 1, the auto-trigger rungs are bypassed. This is the default 
mode of the demo code.

• In mode 2, all rungs are executed. 

Scan_MV_IO_user

Purpose

User-accessible I/O data for the camera. The user app reads and writes 
these I/O tags, and the demo code handles the actual on-the-wire control 
of the camera. 

User App Method

Activate a Control by setting its value to 1. 

The user app can determine that the Control is done when the Control is 
clear (demo code changes the Control to a bit/bool value of 0). Do not 
attempt to activate a Control unless it is clear.

The user app should activate the Controls using one shot writes. The use 
app should not continuously hold a Control in an active state. Holding a 
Control in an active state will prevent the demo code from notifying the 
user app that the Control operation is complete by clearing the Control. 

Usually, when a Control is clear (0), the camera is ready for the Control to 
be activated again. Please see the Specific Control Guidelines and 
Specific Status Guidelines below for qualifications.
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Demo Code Usage

The demo code waits for the user app to activate a Control. When the 
user app activates a Control, the demo code handles all handshaking and 
confirmation that the Control operation is performed by the camera. When 
the operation is complete, the demo code clears the Control back to 0. 

Specific Control Guidelines

GoOnline and GoOffline

In order to take the camera Online and Offline, only one of these Controls 
can go active (change from 0 to 1), and be active, at any given time. 

ResetCount

After the user app activates ResetCount, the demo code will clear 
ResetCount when the operation is complete. The next Inspection output 
will be 1 (as can be seen if AutoVISION is connected to the camera in 
run mode). 

Trigger

Do not trigger the camera unless the TriggerReady Status is active. If 
the Trigger goes active when TriggerReady is not active, the demo code 
increments the counter Scan_MV_trigger_err_count, and immediately 
clears the Trigger Control without attempting to trigger the camera.

After the user app activates the Trigger, the demo code will clear the 
Trigger when the camera indicates it has accepted the Trigger. 

Do not re-trigger the camera until DataValid in the Status register goes 
active, all Inspection data has been processed, and DataValid is cleared 
using the ResetDataValid Control. 

ResetDataValid

When the user app sees DataValid go active, it should process the 
Inspection data, then clear DataValid by activating ResetDataValid. 

See Data Valid for more details.
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ResetError

To clear the Error Status, activate ResetError. 

ExeCmd, CmdCode, CmdArg

These Controls can be used to perform a job change, and query the 
active job slot. The demo code includes tags with pre-defined CmdCode 
and CmdCodeRslt definitions:

The ExeCmd, CmdCode, and CmdArg controls are used in combination 
with these Status signals:

The demo code records the final result of the command operation by 
copying CmdCode, CmdArg, CmdCodeRslt and CmdRet to the 
following tags:
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The demo code will automate the command process when 
Scan_MV_demo_mode is 1, which is the default value at program 
startup, similar to how it assists the Triggering and DataValid Controls. 
The PLC integrator can initiate command operation by accessing the 
demo code’s Scan_MV_IO_user tag set for Control and Status signals. 
While a command operation is active, the demo code forces all Control 
signals to an inactive state, except for the Echo. No Controls can be 
activated until the command operation is completed. To verify the camera 
is still “alive” during command execution, Control.Echo can be 
incremented, and the Status.Echo will update accordingly.

When the demo code automates the command process, the PLC 
integrator is responsible for the following steps:

1. Deactivate all Controls and clear DataValid and Error status signals. 
This is a best-practice measure to ensure that the PLC has 
transitioned from a state of triggering and processing inspections to 
issuing a command.

2. If a job change command is to be issued, populate the output tags 
required to configure the new job (bool, int, long, float, string). 

3. Write the required CmdCode (see Scan_MV_const_CmdCode_xxxx 
tags) and CmdArg, then activate ExeCmd. 

4. Wait for ExeCmd to go inactive (per typical demo mode 1 operation). 
Note that job changes can take up to a minute. While a job change 
command is being executed, the Status.State tag will be 2. 

5. When ExeCmd goes inactive, verify the following:

   Scan_MV_CmdCodeRslt_last is 0 (Success)

   Scan_MV_CmdRest_last contains the returned data from the 
command (if any)

   Status.State has changed to 0 (Offline) or 1 (Online)

   ExeCmdAck is inactive (0)

   Status.Error is inactive (0)

6. Put the camera online (if necessary), and continue with normal 
runtime operation.
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Specific Status Guidelines

Online

The camera cannot be Triggered or generate Inspection data unless 
Online is active. See the GoOnline Control. 

TriggerReady

Do not attempt to trigger the camera unless TriggerReady is active.

See the description of the Trigger for more details. 

TriggerAck and ResetCountAck

Used by the demo code to complete the respective operations. 

DataValid

When DataValid goes active, the user app should process the Inspection 
data, then clear DataValid using the ResetDataValid control. This is 
handled, by the demo code in mode 1 and 2, as a demonstration for the 
user app.

If the camera’s DataValid goes active, but the user app has not cleared a 
previous DataValid event, the demo code does not overwrite 
Scan_MV_IO_user with new Inspection data. Instead, the demo code 
increments the counter Scan_MV_dv_err_count. The new Inspection 
data remains stranded in the Scan_MV_internal tag set, and is 
effectively lost.

Scan_MV_trigger_count

Incremented by the demo code when a new trigger is issued to the 
camera over the EtherNet/IP interface (Trigger Control activated).

Scan_MV_trigger_err_count

Incremented by the demo code if the user app attempts to trigger the 
camera when TriggerReady is not active.
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Scan_MV_dv_err_count

Incremented by the demo code when new Inspection data is received 
from the camera, but the user app has not cleared the previous DataValid.

Scan_MV_status_err_count

Incremented by the demo code whenever the Error Status goes active.

Scan_MV_demo_blob, Scan_MV_demo_decode, 
Scan_MV_demo_InspStat, Scan_MV_demo_measure

Purpose

These tags record counts and min and max values of several EIP IN data 
members.

The demo code expects a demo vision job to be loaded on the camera, 
and a demo target to be in the camera’s field of view. The demo PLC code 
will operate without the demo vision job being loaded on the camera. 
However, the data records will not be valid. 

The demo vision job has the following data members linked to certain job 
tools:

IN

Bool1 = Measure status (pass/fail)

Bool2 = Decode+Matchcode status (pass/fail)

Bool3 = Blob count status (pass fail)

Long1 = Blob count

Float1 = Measure value 

String1 = Decode text

OUT

Long101 = Blob count minimum count tolerance

Long102 = Blob count maximum count tolerance
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Float101 = Measure lower tolerance

Float102 = Measure upper tolerance

String101 = Matchcode

Each tag set records the following data for each vision job tool result received in the 
Inspection report:
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User App Method

The user app can follow the demo code’s usage of these tags for further application logic 
development.

During runtime, the user app can change the OUT data members, and observe the 
change in tool status after a new trigger. 

Specifically, the PLC integrator would typically modify the logic beginning at the following rungs:

Demo Target

The demo vision job uses predefined images. It is unnecessary to have the camera aimed 
at any specific target. If preferred, the job can be changed to enable the camera’s image 
sensor. In this case, the demo targets should be printed approximately 2.5 inches (63 
mm) wide by 1.6 inches (40 mm) tall, centered on white paper larger than the camera’s 
field of view, and presented to the camera with the Data Matrix symbol on the right:

“Pass” Image
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“Fail” Image

Demo Code Usage

The user app example of the demo code watches for Data Valid. When it goes active, the 
user app example processes the user I/O data, updates each demo record with the 
results, then uses ResetDataValid to clear DataValid.

Scan_MV_IO_internal, Scan_MV_ons_internal

Purpose

Used by the demo code to manage the camera. 

User App Method

None. The user app must not attempt to read or write to this tag set.

Demo Code Usage

The demo code uses this tag set to abstract the on-the-wire control of the camera from the 
user app. 
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Run the Camera: Runtime Operation of EtherNet/IP Demo

At this point in the evaluation, it is assumed that you have downloaded the demo vision job 
to the camera and that your PLC is running the EtherNet/IP demo code and exchanging 
data with the camera. The PLC can now parameterize, trigger and monitor the camera 
over EtherNet/IP. 
6-16 AutoVISION and Visionscape Industrial Protocol User Manual
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CHAPTER 7 Omron PLC Setup for 
EtherNet/IP Operation

This section describes how to set up an Omron PLC for EtherNet/IP 
operation using a Vision HAWK Smart Camera and CX-One software.

Notes: 

• The camera communications protocol must be enabled for 
EtherNet/IP before it can be used in this environment. Refer to 
Chapter 1, Protocol Switching in AutoVISION and Visionscape 
FrontRunner, for information about enabling and switching 
communications protocols.

• AutoVISION and FrontRunner jobs use Microscan Link functionality 
to accommodate EtherNet/IP communications between the camera 
and the PLC. For information about how to connect job parameters 
and outputs to Microscan Link tags, refer to the Microscan Link > 
Link Menus section of Chapter 4 in the AutoVISION Software User 
Manual, and to the Linking Datums to Microscan Link Tags section 
of Chapter 2 in the Visionscape FrontRunner User Manual.
AutoVISION and Visionscape Industrial Protocol User Manual 7-1
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Setting Up an Omron PLC

This section was created using the following Omron software and hardware:

• CX-Programmer version 9.43

• Network Configuration version 3.55

• PLC CJ2M CPU31

Start the CX-Programmer application and select menu item File > New. Enter the desired 
Device Name. Select the Device Type and then click Settings to the right of the Device 
Type menu.

In the Device Type Settings dialog, select the correct CPU Type and click OK.
7-2 AutoVISION and Visionscape Industrial Protocol User Manual
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Select USB from the Network Type menu and click OK.

Connect to the PLC via USB connection. Select the menu item PLC > Work Online or 
click the online icon in the tool bar. When prompted, click Yes to complete the connection.

Once successfully connected, the background of the right pane will turn gray and the 
online icons in the ribbon will remain clicked.

To complete the next steps the PLC must be in Program Mode. Right-click the PLC node 
in the tree view in the left pane and select Operating Mode > Program.
AutoVISION and Visionscape Industrial Protocol User Manual 7-3
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To register the I/O table, double-click IO Table and Unit Setup.

Select Options > Create.

Click Yes at the I/O table creation prompt. Click Yes at the Initialize CPU bus settings 
prompt. Click Transfer at the transfer prompt. Click OK at the results prompt. The IO table 
will now be updated with the current PLC hardware settings.
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To edit the EtherNet/IP items and mapping, double-click the EtherNet/IP node.

Input the desired IP settings and then click Transfer [PC to Unit].

When prompted to transfer, click Yes. After the transfer prompt click Close. When 
prompted to restart the unit click Yes. Once the unit resets, click OK at the prompt. Close 
the IO edit dialog.

Physically power down the unit and adjust the rotary switches to match the last octet of the 
new IP address from above. Then power the unit back on.
AutoVISION and Visionscape Industrial Protocol User Manual 7-5
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Set the CX-Programmer application to offline by selecting PLC > Work Offline or the 
online icon in the ribbon.

In the CX-Programmer application, double-click the PLC node. In the Network Type menu, 
select EtherNet/IP. Click Settings to the right of Network Type and enter the PLC’s new IP 
address. Click the OK buttons to close the dialogs.

Set the CX-Programmer back to online. You will be prompted with a connection via 
EtherNet/IP. Click Yes to complete the connection.

Double-click the IO Table and Unit Setup node. Expand the Built-In Port/Inner Board 
node. Right-click and select Start Special Application > Start with Settings Inherited.
7-6 AutoVISION and Visionscape Industrial Protocol User Manual
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Select Network Configurator and click OK. Select port TCP:2 and click OK. Then click 
OK for EtherNet/IP_1 connection.

To install the EDS file, select EDS File > Install. Navigate to the EDS folder 
C:\Microscan\Vscape\Firmware\eds\VisionHAWK. Select the correct file and click 
Open to load the file. All other EDS files can be downloaded from www.microscan.com.

Expand the left tree view to open the OMRON Corporation files. Locate CJ2M-EIP21 for 
this example and drag it to the line in the right pane.
AutoVISION and Visionscape Industrial Protocol User Manual 7-7
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Chapter 7 Omron PLC Setup for EtherNet/IP Operation
Expand the Vendor Collection node for the camera connected to the PLC and drag it to 
the line in the right pane.

Right-click near the newly-added icons and select Change IP Address. Enter the IP 
address for the PLC and the camera or reader attached and click OK.

Double-click the PLC icon to edit the device parameters. This is where you will be linking 
and mapping the EtherNet/IP assembly data to the internal memory of the PLC. Select the 
Tag Sets tab. Select the In - Consume tab at the top. Click Edit Tags below. Then click 
New to edit/create a new tag. In this example we are naming this tag 300 for the 
peripheral memory linked to the input data. Select the size (320 bytes) for the entire input 
assembly. Click Regist then Close to continue.
7-8 AutoVISION and Visionscape Industrial Protocol User Manual
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Select the Out - Produce tab and then click New. For the output assembly you are going 
to map to peripheral memory address 500 with 320 bytes. Click Regist and then Close. 
Click OK on the Edit Tags dialog. When prompted to register new tags click Yes.

Click the Connections tab on the Edit Device Parameters dialog. Click the download 
button in the middle to register the device.
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In the lower pane, double-click the PLC in the registered device list. This will open the 
linking dialog. If there are multiple connection types, they can be selected from the 
Connection I/O Type menu. In the Originator Device section, select the Input Tag then 
the Output Tag. Adjust the RPI if needed. When done, click Regist and then Close.

The registered device will now display the tags that are linked. Click OK to continue.
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Download the new tags and links to the PLC by selecting Device > Parameter > Download 
or by clicking the download icon in the ribbon. Click Yes when prompted to download.

When the List of Devices That Are Executing dialog appears, select the PLC and click 
Download after Changed to Program Mode. When prompted to return the state, click 
Yes to continue.

Select Network > Check Connection in the Network Configurator to ensure that there 
are no connection problems.
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CHAPTER 8 Using PROFINET I/O

This section provides information necessary for using the Vision HAWK in 
a PROFINET I/O environment.

Notes: 

• The camera communications protocol must be enabled for 
PROFINET I/O before it can be used in this environment. Refer to 
Chapter 1, Protocol Switching in AutoVISION and Visionscape 
FrontRunner, for information about enabling and switching 
communications protocols.

• AutoVISION and FrontRunner jobs use Microscan Link functionality 
to accommodate PROFINET I/O communications between the 
camera and the PLC. For information about how to connect job 
parameters and outputs to Microscan Link tags, refer to the 
Microscan Link > Link Menus section of Chapter 4 in the 
AutoVISION Software User Manual, and to the Linking Datums to 
Microscan Link Tags section of Chapter 2 in the Visionscape 
FrontRunner User Manual.
AutoVISION and Visionscape Industrial Protocol User Manual 8-1



Chapter 8 Using PROFINET I/O
Vision HAWK PROFINET I/O

PROFINET I/O Identity

Vendor ID

Microscan’s Vendor ID is 0x0257.

Device ID

The Device ID is 6899.

Connection Properties: RT Cyclic Messaging
Odd slot numbers are input to the PLC, even slot numbers are output from the PLC.

Maximum data size in either direction is 518 bytes. The data size can be reduced by 
removing slots that are not used.

Cycle update time: 16ms

Slot/Subslot Layout Descriptions
8-2 AutoVISION and Visionscape Industrial Protocol User Manual
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Slot Data Layout Diagrams
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STEP 7 PLC Slot Layout
8-8 AutoVISION and Visionscape Industrial Protocol User Manual
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Status: Camera Status Register (16-bit)

Each bit of this register represents a signal that displays the camera’s operational status. 
A high value of 1 indicates that the signal is active (true).
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CmdCodeRslt (32-bit)

The value of CmdCodeRslt is only valid when ExeCmdAck is active (1), in response to 
ExeCmd being active.

CmdRet (32-bit)

The value of CmdRet is only valid when ExeCmdAck is active (1), in response to 
ExeCmd being active, and CmdCodeRslt is 0 (Success). The following chart shows 
which CmdCodes return data in the CmdRet register.
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State (16-bit)

State reflects the following operational condition of the camera:
AutoVISION and Visionscape Industrial Protocol User Manual 8-11
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The value of State determines which Control and Status signals are available:
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VIO Output Register Bits

VIO Input Register Bits

Control: Camera Control Register (16-bit)

Each bit of this register controls a function on the camera. Transitions from a low state of 0 
to a high state of 1 initiate the associated operation. The PLC should return the state of the 
control bit back to 0 after it has acknowledged the camera has processed the control. 
Unused bits should remain 0.
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CmdCode and CmdArg (32-bit)

Specifies the process invoked in the camera when Control.ExeCmd goes active.

List of Available CmdCodes and Associated CmdArg

CmdCode and ExeCmd Operation
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PROFINET I/O Control/Status Signal Operation
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CHAPTER 9 Demo PROFINET I/O PLC 
Code

This section describes how to use Microscan demo PLC code with a 
vision job and camera target.

The PROFINET I/O demo files can be found where AutoVISION is 
installed, in the folder C:\Microscan\Vscape\Tutorials and Samples\Vision 
Hawk\PROFINET demo. Open PNIO_Demo.avp and PNIO_demo_job2.avp 
with AutoVISION and download them to the camera. 

Notes: 

• The camera communications protocol must be enabled for 
PROFINET I/O before it can be used in this environment. Refer to 
Chapter 1, Protocol Switching in AutoVISION and Visionscape 
FrontRunner, for information about enabling and switching 
communications protocols.

• AutoVISION and FrontRunner jobs use Microscan Link functionality 
to accommodate PROFINET I/O communications between the 
camera and the PLC. For information about how to connect job 
parameters and outputs to Microscan Link tags, refer to the 
Microscan Link > Link Menus section of Chapter 4 in the 
AutoVISION Software User Manual, and to the Linking Datums to 
Microscan Link Tags section of Chapter 2 in the Visionscape 
FrontRunner User Manual.
AutoVISION and Visionscape Industrial Protocol User Manual 9-1



Chapter 9 Demo PROFINET I/O PLC Code
Overview

In this demonstration, you will learn how to load a saved job into the 
camera, establish connectivity via PROFINET I/O to a Siemens S7 PLC, 
and run some example programs that interface with the camera.

While evaluating PROFINET I/O capabilities, you will:

• Begin with AutoVISION.

Open a sample PNIO demo vision job in AutoVISION and use the Try Out 
feature to learn what to expect from the camera before it is connected to 
the PLC.

• Prepare the PLC.

Integrate the camera into the PLC environment with STEP 7 software and 
the GSD file.

• Run the camera.

Trigger the camera while it is online with the PLC and observe changes in 
the Inspection status as the PLC reconfigures the vision job’s parameters.
9-2 AutoVISION and Visionscape Industrial Protocol User Manual
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AutoVISION Setup

Prior to starting AutoVISION, make sure the camera is either connected 
to the PLC or both PLC and camera are on the same physical network. 
Ensure that the PC, PLC, and camera have the same network class and 
corresponding subnet addresses.

Open AutoVISION and select the camera.

From the Image view, click the Load a Job button. Then navigate to 
\Microscan\Vscape\Tutorials And Samples\Vision Hawk\PROFINET 
demo. Select PNIO_demo.avp.



Chapter 9 Demo PROFINET I/O PLC Code
The demo job will include three tools: Measure, Decode, and Count Blobs.

Each tool has data items linked to the PROFINET I/O structure as shown here.

This data is transferred cyclically between the camera and PLC. 
9-4 AutoVISION and Visionscape Industrial Protocol User Manual
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Once the job has loaded, the next step is to link the pre-saved images on 
the local PC. On the Camera button, click the far left icon to select and 
load an image.

A file browser will open. Then navigate to the same folder where the 
demo job was loaded PROFINET I/O Demo. If the images are located, 
the icon will change from a camera to a folder.

By clicking the Try Job Once icon, the application will cycle through the 
entire job with the loaded image.
AutoVISION and Visionscape Industrial Protocol User Manual 9-5
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There are two images on file. One will pass all three inspections and one will fail all three.

Now click the Run button on the top ribbon. This will download the job to the camera. 

At this point the job is ready to run and can be tested. However, in order to run the job 
change demo this job needs to be loaded into Slot 1. Click back to the Edit view from the 
top ribbon bar.

Click the slot icon and select Slot 1 or New Slot if no slots are currently in use.

Now the job and images will be saved to the flash memory of the camera.
9-6 AutoVISION and Visionscape Industrial Protocol User Manual
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STEP 7 Setup
This section was created using Siemens STEP 7 software version 5.5 + 
SP2 and an ET200S PLC, catalog number 6ES7 151-8AB01-0AB0, CPU 
Version 3.2. It was tested with a 315-2 PN/DP PLC, catalog number 
6ES7-315-2EH13-0AB0, CPU Version 2.6.

First launch the SIMATIC Manager from the desktop.

Create a new project from the menu item File > New. Select the project 
location on disk then enter the name and click the OK button. In the 
example below, the name is Start. Once the project is first created, you 
will see the dialog. This dialog is the main entry point into the PLC 
program and hardware settings.
AutoVISION and Visionscape Industrial Protocol User Manual 9-7
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The PC may have multiple network cards so it’s imperative to map the 
correct one to the SIMATIC software. From the menu, select Options > 
Set PG/PC Interface. This will open the Set PG/PC Interface dialog and 
list the available network cards. On the Access Path tab select the NIC 
card with (TCP/IP >) in the name.

In the SIMATIC Manager dialog, right-click and select Insert New Object. 
This is where you will select the base station. For example, when 
configuring an ET200-s, select SIMATIC 300 Station since it’s based on 
the 300 series CPU.
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After the station has been added, right-click and add Industrial Ethernet.

Expand the Start tree node on the left pane and click the station. On the 
right pane you will see a Hardware icon.
AutoVISION and Visionscape Industrial Protocol User Manual 9-9



Chapter 9 Demo PROFINET I/O PLC Code
Double-click the Hardware icon to launch the HW Config dialog.

Make sure the Catalog is selected in the ribbon bar on the top. This will 
add a tree view on the right pane with all the available hardware devices.

If the latest GSDML file hasn’t been imported, follow the next steps to 
import.

GSDML

• Install the GSD file from the menu item Options > Install GSD File.

• Click the Browse button to locate the GSDML file 
\Microscan\Vscape\Firmware\gsd\visionhawk.
9-10 AutoVISION and Visionscape Industrial Protocol User Manual
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• The center pane will list the available GSDML files.

• Select the file and click the Install button.

• When finished, close the dialog.

• The Vision HAWK camera should now be present in the PROFINET 
I/O section as shown below.



Chapter 9 Demo PROFINET I/O PLC Code
Add the CPU from the catalog view by drag and drop or double click. 
Make sure the catalog number and version matches the PLC exactly. The 
catalog number will be displayed on the bottom of the view.

Some CPUs are modules that will require a generic rack to be added 
prior. If your PLC requires a rack, you will be prompted to add the rack 
prior to being allowed to insert the CPU module.

After the CPU is added, a popup dialog will prompt the Properties relating 
to the IP information.
9-12 AutoVISION and Visionscape Industrial Protocol User Manual
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Select Ethernet(1) on the bottom list box and enter the correct IP address 
of the CPU.

Once the CPU has been added, add any additional expansion modules, if 
installed. Click the CPU on the left pane and the bottom pane will list the 
available ports and slots. 
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Add the camera in the location (PROFINET I/O > Additional Field 
Devices > General > Microscan). The camera can be added by drag 
and drop to Ethernet(1): PROFINET-I/O System (100) or by selecting the 
Ethernet(1) line first and double clicking the camera. Once the camera 
has been added the icon will appear on the configuration dialog.

Once the camera has been added, double click the icon to open the 
properties dialog. Under the device name, enter the existing name of the 
camera or a unique name.
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If a unique name is used, the device has to be manually updated. View 
Updating camera name section.

Click the camera icon and the data slot address mapping will be displayed 
below. Take note of the address values since they will be needed in the 
demo application. Since there is an infinite combination of modules and 
slot configurations, the addressing is unique to every setup.
AutoVISION and Visionscape Industrial Protocol User Manual 9-15
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Once the hardware configuration has been completed, it’s time to compile 
and download. Click the compile and save icon on the ribbon. If there are 
any configuration conflicts, the application will prompt a warning at this point.

Once compiled, click the download icon on the ribbon to send the 
information to the PLC.

At this point close or minimize the HW Config dialog and re-visit the 
SIMATIC Manager dialog. The CPU should be added next to the 
Hardware icon and in the tree view in the left pane. Expand the CPU tree 
item and remaining child items below it.
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Click the Blocks node to view the program objects.

Updating Camera Name 

From the HW Config dialog open Edit Ethernet Node from the menu item PLC > 
Ethernet > Edit Ethernet Node. From the SIMATIC Manager dialog open Edit Ethernet 
Node from the menu item PLC > Edit Ethernet Node.

Click the Browse button to open the node selection dialog.
AutoVISION and Visionscape Industrial Protocol User Manual 9-17
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Select the camera and click the OK button.

Edit the Device Name, if necessary, to match the name entered previously 
in the Vision HAWK properties dialog, and click the Assign Name button.

Importing Example Program
From the SIMATIC Manager, open the example program from the menu 
File > Open. Click the Browse button to locate the (AVDemo) program. 
The AVDemo is located in \Microscan\Vscape\Tutorials and 
Samples\Vision HAWK\PROFINET Demo.
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Split both example and current projects in the dialog as shown.

Select the objects minus the System data object and copy with right-click > copy or 
CTRL+C. Paste into current project with right-click > past or CTRL+V. When prompted 
that OB1 already exists, click the Yes button to overwrite it. Now the example program is 
imported to the current project.

Select the Blocks icon on the left pane. Then click the download button on the top ribbon. 
This will download the new copied functions and system data to the PLC. Now it’s time to 
update the new addressing from the hardware installation prior. Double-click the OB1 
block to open the LAD/STL/FBD editor. OB1 is the main routine of the PLC program.
AutoVISION and Visionscape Industrial Protocol User Manual 9-19



Chapter 9 Demo PROFINET I/O PLC Code
9-20 AutoVISION and Visionscape Industrial Protocol User Manual

Scroll down to Network 4. This is where the data is mapped from the camera to the local 
data structure. FC3 is a function that pushes the input data from the camera to the 
program structure. Click the numbers to match the address on the hardware as shown. 
Click the following buttons on the popup dialogs:
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Note: This is the address mapping view of the Vision HAWK module which is derived from 
the hardware config view. Refer to page 9-10 for details on displaying the hardware config 
view. Refer to page 9-15 for details on displaying Vision HAWK address mapping.

Repeat the same steps for Network 5 to update the output data mapping. Keep in mind 
that all input addresses are under the (I address) column and the output addresses are 
under the (Q address) column. Save to the PC and download to the PLC.

Do a master reset and set the PLC to RUN mode. Make sure all LEDs indicate good.
AutoVISION and Visionscape Industrial Protocol User Manual 9-21
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Running the Demo

In the SIMATIC Manager dialog, double click the VAT_1 icon. This will 
open the variable table dialog for the data type demo. Maximize the 
internal dialog to increase the viewing area.

To establish a live connection to the PLC, click the Monitor Variable 
button on the ribbon. This will update data from the PLC to the dialog. The 
top title bar will go blue and the bottom status will show run with a green 
progress bar.
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There are two demo modes in this example. The modes are set in 
“USER”.Demo.DemoMode (DB101.DBW 2).

0 = AutoVISION Test

1 = Job Change Test

The AutoVISION Test will demonstrate communications between the PLC and the current 
job loaded from AutoVISION.

If 0 doesn't appear under the Status Value column, right-click in the 
"USER".Demo.DemoMode row under the Modify Value column. Select Modify or type 
CTRL+F9 to change the value. 

If 0 is not entered in the Status Value column of the “USER.Demo.DemoTrigType” row, 
enter 0.

To start triggering the Vision HAWK program, right-click inside the Status Value column of 
the “USER.Demo.DemoTrigType” (DB101.DBW 0) row. 

Change the value from 0 to 1 to begin triggering and running the job on the camera.
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When the program is triggering the camera, each cycle will produce either a pass or fail all 
state. Each state is counted in “USER”.Demo.CountPass: 

and “USER”.Demo.CountFail:

These counters can be cleared by right-clicking the row “USER”.Demo.ClearCounters 
and selecting Modify Address to 1. 

The tolerances are below the counters. The inspection values and status bits are below 
the tolerances.

In some instances a large job could take longer to load. Increment the delay time to adjust for 
job size. The image below shows Function Block 4, Network 6, where the delay is located.
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To run the Job Change Test you first need to use AutoVISION to download another job to 
slot 2 on the camera. In AutoVISION, connect to the camera and select the Connect icon 
at the top of the user interface. Click the Load a Job icon. Locate PNIO_demo_job2.avp 
and click the Open button. Once the job has loaded into AutoVISION, click the Edit button 
at the top of the user interface. Then click Save the Job to a Slot on the camera icon in 
the menu at the top of the user interface. Select New Slot, which should be 2. When switching 
between tests, disable the current routine by setting the "USER".Demo.DemoTrigType to 0.

Now there should be two jobs loaded in the camera’s flash memory. Using the SIMATIC 
Manager, open VAT_1. Click the Monitor Variable icon. On the row 
"USER".Demo.DemoMode, right-click and modify to one. Right-click the row 
"USER".Demo.DemoTrigType and Modify Address to 1 to start the demo. AutoVISION 
should be closed for this demo to work.

This demo will cycle through loading jobs from slots 1, 2, and 3. Each cycle will be counted 
in the variable table "USER".Demo.CountExecutions. The job load success is 
determined by the camera’s status register "PNIO.Input.CmdCodeRslt" = 0x0. If the job 
load is successful the counter "USER".Demo.CountPass will increment. If the job load 
fails when "PNIO".Input.CmdCodeRslt ! = 0x0, then the counter 
"USER".Demo.CountFail will increment.

OB1 calls FB1 to process the AutoVISION test. To view the ladder logic, select FB1, right-click, and 
select Called Block > Open. Then select the main menu item Open ONLINE to view processes.
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